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INSTALASI SISTEM

1. Install Arduino IDE
Buka browser anda, masukan https:/www.

arduino.cc/en/Main/Software di kolom url browser anda.

Akan muncul seperti gambar berikut:

Gambar 1. Download Page Arduino IDE

Sesuaikan sistem operasi yang sedang di gunakan,
diasumsikan bahwa menggunakan sistem operasi
Windows, jadi silahkan anda klik Windows Installer.
Setelah diklik, Arduino IDE proses di download. Setelah

terdownload maka install program Arduino IDE tersebut.
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Setelah selesai install, sekarang masuk ke program
Arduino IDE yang sudah terinstal. Selain versi Windows
installer dapat dipilih versi zip. Untuk versi zip, setelah
melakukan download program lakukan ekstrak file
tersebut sehingga menjadi kumpulan file Arduino yang
tersimpan dalam sebuah folder Windows. Tampilannya

akan seperti berikut:

Gambar 2. Tampilan awal Arduino IDE

Setelah terekstrak dan file Arduino dijalankan maka
secara default akan muncul dua buah fungsi (void) yaitu
void setup yang befungsi mendeklarasikan fungsi-fungsi
Arduino dan void setup yang berfungsi untuk membuat

program utama.

Fakultas limu Komputer
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Sebelum membuat program pastikan mikrokontroler
terhubung dengan computer yang dipastikan dengan
melihat fools pada IDE Arduino untuk memastikan Board
Arduino yang digunakan sama dengan seting di
softwarenya, missal menggunakan mikrokontroler
Ardummo Uno pastikan boardnya juga dipilih sesuai
dengan hardwarenya.

Selanjutnya memastikan port yang dinamakan
Arduino telah tercentang atau terpilih oleh software
Arduino, jika belum ada lakukan update driver serial.
Untuk gambar koneksi board dan koneksi serial seperti

ditunjukkan dibawah ini.
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Gambar 3. Koneksi Ke Board Arduino
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Gambar 4. Koneksi ke Comm Port di Komputer

Untuk menguji apakah boardnya berfungsi atau
tidak dapat diuji menggunakan program dasar yaitu
“Blink” vyang telah disediakan oleh Arduino dan
diletakkan pada folder example dan sub folder Basic
kemudian cari file Blink, seperti ditunjukkan pada gambar
berikut ini.

| Fakultas lmu Komputer
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Gambar 5. Program Blink

Install Board Wemos di Arduino IDE
Setelah Arduino IDE ter-install, selanjutnya harus
menginstall Board Wemos agar bisa melakukan
pengembangan di Board Wemos melalui program
Arduino IDE. Pertama buka browser lalu ketikan link ini
yang ada di kolom url browser berikut ini. https:/github.
com/esp8266/Arduino disitu dapat ditemukan tutorial

bagaimana install board wemos di board manager Arduino

MANUAL USER 5
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IDE. Berikut ditunjukan bagaimana instalasi board wemos

di board manager Arduino IDE:

Gambar 6. Install Board Wemos ke Arduino IDE

Jika belum menemukan path json untuk board
Wemos ini, dapat dicari di github. Alamat URL untuk
keperluan di atas dapat dibrowsing di Google Secarch
Engine dengan kata kunci “github json esp8266™
kemudian cari title yang mengandung alamat link path
json wemos seperti ditunjukkan pada gambar di bawah

ni.

Fakultas llmu Komputer
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instalfing with Boarcs Manager

Gambar 7. Path json Wemos D1 mini

Copy kan text yang diber1 kotak warna merah ke
Arduino IDE. File > Preferences > Additional Boards
Manager Urls. Seperti gambar berikut:
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NP REHOVO \Becutie st Ar ]
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Gambar 8. JSON Board manager Arduino IDE
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Setelah itu update board manager dengan seting di

Tools > Board “Arduino/Genuino Ino” > Board Manager.

Selanjutnya tulis di kolom search ESP8266 seperti

gambar berikut.

DU, Mo 3 16

3, 1EBE 17 MU, WESINICL 10 (130 12K
B W) Thovsls, Do stfes BB 2N, WebES 1hi.

e
Wb (1 e, S (P47 3
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Gambar 9. Install board wemos dan modul ESPR266

Setelah
sémua prosecs
di atas selesai,
maka board
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muncul  pada
pilihan
menu Tools ->
Board seperti
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Gambar 10. Mengenal Board Wemos D1 Mini
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Gambar 13. Code Client Identifikasi Kendaraan

d. Ganti nilai ssid dengan nopol yang sudah
terdaftar di  WebService identifikasi ken-
daraan  http://identifikasi.inodroid-narotama.
id melalui admin. Seperti gambar berikut.

MANUAL USER 1 1
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Daftar Pengguna
Pemilik Kendaraan

-------

Gambar 14. Daftar Pemilik Kendaraan

Setelah terdaftar maka di Arduino IDE
klik tombol Upload. Dari sini telah berhasil
melakukan instalasi Board Wemos D1 Mini
sebagai Client.

Fakultas limu Komputer
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INSTALASI CHIP DIVES

Instalasi Board Wemos sebagai Client
Dalam instalasi Client di Board Wemos

dibutuhkan Editor Arduino IDE yang sudah
dijelaskan di atas langkah-langkah instalasi-nya,
dan juga Board Wemos D1 Mini. Berikut
langkah-langkah instalasi Client di Board Wemos
D1 Mini.

a. Buka Arduino IDE lalu ubah Settingan Board
yang semula default ke “Wemos D1 Mini”,
seperti gambar berikut.

@

Gambar 11. Seting Board Wemos D1 Mini

MANUAL USER |
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b. Setelah Arduino IDE dibuka dan Board sudah
diubah sesuai dengan kebutuhan, selanjutnya
hubungkan USB dari Board Wemos D1 Mini
ke USB Port PC/Laptop. Setelah itu hubung-
kan ke Arduino IDE dengan mengubah Port,
seperti gambar berikut.

Gambar 12. Seting Port yang Digunakan Arduino

c. Selanjutnya buka sumber kode dari Identifikasi
Kendaraan Client dengan cara “File->Open”
atau bisa menggunakan kombi-nasi keyboard
“CTRL+0O". lalu arahkan ke sumber kode, jika
sudah maka akan muncul gambar seperti
berikut.

Fakultas limu Komputer
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2. Instalasi Board Wemos D1 Mini sebagai

Scanner Client

Setelah melakukan instalasi Board
Wemos D1 Mini sebagai Client selanjutnya
lakukan instalasi Board Wemos D1 Mini
sebagai Scanner Client yang berfungsi sebagai
alat perekam nopol yang sudah tertanam pada
Board Wemos D! Mini. Berikut langkah-
langkah instalasi Board Wemos DI Mini

sebagai Scanner Client.

B

Gambar 15. Seting Wemos D1 Mini

MANUAL USER | 1 3
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a. Buka Arduino IDE anda lalu ubah Settingan
Board yang semula default ke “Wemos DI

Mini”, seperti Gambar 15 berikut.

b. Setelah Arduino IDE dibuka dan Board
sudah diubah sesuai dengan kebutuhan,
selanjutnya hubungkan USB dari Board
Wemos D1 Mini ke USB Port PC/Laptop.
Setelah itu hubungkan ke Arduino IDE
dengan mengubah Port, seperti gambar

berikut.

Gambar 16. Seting Port Arduino yang Digunakan

Fakuitas llmu Komputer
Universitas Narotama Surabaya
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C.

Selanjutnya buka sumber kode dari
Identifikasi  Kendaraan Scanner Client
dengan cara “File->Open” atau bisa meng-
gunakan kombinasi keyboard “CTRL+Q”.

lalu arahkan ke sumber kode, jika sudah

maka akan muncul gambar seperti berikut.

Gambar 17. Kode Scanner Identifikasi

Setelah berhasil membuka sumber kode
Identifikasi  Kendaraan  Scanner List
perhatikan kotak hitam pada gambar di atas.
Ada tulisan ssid & pass. Ubah nilai ssid &
pass sesual dengan koneksi WiFi yang saat

ini anda gunakan. Setelah diubah, silahkan

MANUAL USER | 15
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anda klik tombol Upload dan tunggu
beberapa saat maka alat Scanner Client

sudah terinstall di Board Wemos D1 Mini.

3. Melakukan Testing pada Kkedua Alat

16

Identifikasi Kendaraan

Setelah melakukan kedua tahap instalasi
pada Board Wemos D1 Mini sebagai client dan
scanner identifikasi  kendaraan bermotor,
berikutnya dilakukan Testing dari proses
identifikasi  kendaraan langkah-langkahnya
sebagai berikut.

a. Pasang alat client pada kendaraan bermotor
(sepeda motor dana tau mobil) kemudian
beri tegangan modul tersebut pada saat
kendaraan bermotor dinyalakan. Modul
client tersebut akan memancarkan sinyal
wifi berupa SSID plat nomor kendaraan
bermotor sebagai identitas digital kendaraan
tersebut

b. Pasang modul scanner pada lokasi tertentu

yang  digunakan  untuk = mendeteksi

Fakultas llmu Komputer
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kendaraan bermotor tersebut, misalnya di
pintu masuk parker atau di lokasi parker
kendaraan bermotor. Modul scanner tersebut
akan  mendeteksi  sinyal wifi  yang
dipancarkan oleh client yang terpasang di
kendaraan  bermotor,  berupa  SSID
kendaraan bermotor masing-masing.

Buka page http:/identifikasi.inodroid-
narotama. id pada computer yang terhubung
dengan jaringan internet.

Kendaraan bermotor yang berada di area
scanner akan otomatis ke deteksi dan
dimasukkan dalam sebuah  database
komputer

komputer akan merekam plat nomor
kendaraan bermotor  tersebut dan
menampilkan di halaman web tersebut.

Cara mendeteksi sinyal wifi client oleh
scanner dan ditampilkan dalam layar
komputer ditunjukkan dalam diagram di

bawah ini.

MANUAL USER | 17
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Gambar 18. Blok Diagram Sistem Identifikasi Kendaraan
Bermotor
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identifikas: kengaraan

Daftar Kendaraan
yang teridentifikasi

NO  NOPOL LASST SEEN DETAIL

Gambar 19. Tampilan data daftar kendaraan bermotor yang
teridentifikasi
Untuk melihat detail data kendaraan dapat diklik
tombol detail pengguna, maka sistem akan menampil-

kan data secara detail yang ditunjukan dalam gambar

berikut ini.

MANUAL USER | 19
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Gambar 20. Detail Data Kendaraan Bermotor
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LAMPIRAN PROGRAM CLIENT
#include <ESP8266WiFi.h>

#include <WiFiClient.h>

#include <ESP8266WebServer.h>

//silahkan anda isi ssid sesuai dengan nopol anda dan
kosongkan passwordnya

const char *ssid ="L 6125 QZ";
const char *password = "null";

ESP8266WebServer server(80);

void handleRoot() {

server.send(200, "text/html", "<hl>You are
connected</h1>");
}
void setup() {
delay(1000);
Serial.begin(115200);

Serial.println();
Serial.print("Configuring access point...");
WiFi.softAP(ssid, password);

[PAddress mylP = WiFi.softAPIP();
Serial.print("AP IP address: ");
Serial.println(myIP);

server.on("/", handleRoot);
server.begin();

Serial.printIin("HTTP server started");

MANUAL USER | 21
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void loop() {
server.handleClient();}

| Fakultas llmu Komputer
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LAMPIRAN PROGRAM SCANNER
#include <Arduino.h>

#include <ESP8266WiFi.h>

#include <ESP8266WiFiMulti.h>
#include <ESP8266HTTPClient.h>
#include <LiquidCrystal.h>

#include <string.h>

#define MAX STRING LEN 20

ESP8266WiFiMulti WiFiMulti;
LiquidCrystal led(D0, DS, D6, D7, D3, D4);
String val_nopol;

String baris1, baris2, baris3, baris4;

int LoopTime Soll =9;

int LoopTime Angepasst = LoopTime Soll;
int LoopTime_Bisher = LoopTime Soll;
unsigned long LoopTime_Start = 0;

void setup() {
Serial.begin(115200);

led.begin(20, 4);

led.print("Setup LCD Success");
Serial.println("Setup LCD Success");
delay(5000);

led.clear();

WiFi.mode(WIFI_STA);
WiFi.disconnect();
led.print("Scanner is Works!");
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Serial.printin("Scanner is Works!");
delay(5000);
led.clear();

WiFiMulti.addAP("LAB.PAUD", "12345678");
while((WiFiMulti.run() = WL_CONNECTED)){
lcd.print("HTTP 1s Works!");
Serial.printin("HTTP is Works!");
delay(5000);
led.clear():
}

}

void loop() {

val _nopol="";
Serial.printin("scan start");

int n = WiFi.scanNetworks();
Serial.printIn("scan done");
if (n==20)
Serial.println("no networks found");
else
{
Serial.print(n);
Serial.println(" networks found");
for (int i =0; i <n; ++i)
{
Serial.print(i+ 1);
Serial.print(": ");
Serial. print(WiFi.SSID(1));
Serial.print(" (");
Serial print(WiFi.RSSI(1));
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Serial.print(")");
Serial.printin((WiFi.encryptionType(i) ==
ENC TYPE NONE)T™ ')
sendRequest(WiFi.SSID(i));
delay(10);
}

}
Serial.printIn("");

LoopTime_Bisher = millis() - LoopTime_Start;
ifiLoopTime_Bisher < LoopTime_Soll){
delay(LoopTime_Soll - LoopTime Bisher);
}
LoopTime_Angepasst = millis() - LoopTime_Start;
LoopTime_Start = millis();
}

void sendRequest(String nopol){
int setcursor = 0;
HTTPClient htip;

http.begin("http://128.199.133.21/identifikasi/public/ap
/communicate");

http.addHeader("Content-Type", "application/x-www-
form-urlencoded");

int httpCode = http.POST("nopol=" + nopol);
String payload = http.getString();

Serial.print("Code: ");
Serial.printin(httpCode);
Serial.printIn("Payload: " + payload);
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if(payload.tolnt() == 200)/
displayCursor(nopol + " i1s found"):
delay(1000);

Serial.printIn("This nopol: " + nopol);

http.end();
H

void displayCursor(String nopol) {
baris4 = baris3;
baris3 = baris2;
baris2 = baris1;
baris] = nopol;

led.setCursor(0,0);
led.print(baris1);

lcd.setCursor(0,1);
led.print(baris2);

led.setCursor(0,2);
lcd.print(baris3);

Icd.setCursor(0,3);
led.print(baris4);}

LAMPIRAN PROGRAM WEB SERVICE

<?php

namespace App\Http\Controllers;
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use
Illuminate\Foundation\Bus\DispatchesJ
obs;

use Illuminate\Routing\Controller as
BaseController;

use
Illuminate\Foundation\Validation\Vali
datesRequests;

use
Illuminate\Foundation\Auth\Access\Aut
horizesRequests;

class Controller extends
BaseController
{ .

use AuthorizesRequests,
DispatchesJobs, ValidatesRequests;
}

<?php

namespace App\Http\Controllers;
use Illuminate\Http\Request;
use App\Kendaraan;

use App\History;

class CommunicateController extends
Controller /|

public function
checkNopol (Request $request)
$nopol = $request->nopol;

MANUAL USER | 7
Dives Digital Identification Vehicle Sistem |



$resultNopol =
Kendaraan: :where ("nopol", Snopol)-
>get () ;

if ($resultNopol->count () >

0) {
SdataKendaraan =
$resultNopol->first();
$dataHistory = |

"id_kendaraan" =>
SdataKendaraan->id,

"nopol" =>
SdataKendaraan->nopol,

"tgl update" =>
date ("Y-m~-d H:i:8")

u
SdataHistory);
SresultHistory) {
titrn 200

} else {

return 502;

1If
Sre
History::create
i

}
) else |
return 500;

<?php
namespace App\Http\Controllers;
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use Illuminate\Http\Request;
use App\Pengguna;

class PenggunaController extends
Controller ({

public function index() ({
$status = S$this-
>retrovitResponse("success“,
"success", 200, false);
return response () -
>json(array("status" => S$status,
"data" => Pengguna::all()), 200);
!

public function show (Pengguna
$pengguna) |
$status = S$this-
>retrovitResponse ("success",
"success", 200, false);
return response () -
>json(array("status" => Sstatus,
"data" => $pengguna)) ;
}

public function store (Request
Srequest) {
$pengguna =
Pengguna::create(Srequest—>all{)};
$status = $this-
>retrovitResponse("success",
"success", 201, false);
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return response()-
>json(array ("status" => S$status,
"data" => S$pengguna), 201);
1
!

public function update (Request
Srequest, Pengguna S$pengguna) |
$pengguna->update (Srequest-
>all()):
Sstatus = S$this-
>retrovitResponse ("success",
"success", 200, false):

return response()-
>json (array ("status" => $status,
"data" => Spengguna), 200);
}

public function delete (Pengguna
Spengguna) {
Spengguna->delete () ;
Sstatus = S$this-
>retrovitResponse ("success",
"success", 200, false);

return response() -
>json (array("status" => $status),
204) ;
}

public function
rovitResponse ($type, Smessage,
de, Serror)

$data = array |

ret
Sco

Fakultas llmu Komputer
30 Universitas Narotama Surabaya




npype" => STYPE

"nessage" => Smessage,
wcode" => Scode,
"ayrror" => $error

)i

return $data;

<?php
namespace App\Http\Controllers;

use Illuminate\Http\Request;
use App\Kendaraan;

class KendaraanController extends
Controller {

public function index () ({
$status = $this-
>retrovitResponse ("success”,
"success", 200, false);
return response ()
>json(array("status" => S$status,
"data" => Kendaraan::all())

}

public function show(Kendaraan
Skendaraan) {
Sstatus = S$this-
>retrovitResponse ("success",

"success", 200, false);
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return response()-
>json(array("status" => S$status,
"data" =>
Kendaraan: :where ("id_pengguna",
$kendaraan->id pengguna)->first()));

}

public function store(Request
S$request) {
Skendaraan =
Kendaraan::create ($request->all());
$status = Sthis-
>retrovitResponse ("success",
"success", 201, false);

return response()-
>json (array("status" => $status,
"data" => S$kendaraan), 201);
}

public function update (Request
Srequest, Kendaraan $kendaraan) ({
Skendaraan->update (Srequest-
>all());
Sstatus = S$this-
>retrovitResponse ("success",
"success", 200, false);

return response()-

>json{array("status" => $status,
"data" => S$kendaraan), 200);

}
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public function delete (Kendaraan
Skendaraan) {
Skendaraan->delete () ;
Sstatus = S$this-
>retrovitResponse ("success",
"success", 200, false);

return response () -
>json (array("status" => $status),
204) ;

.l

public function
retrovitResponse ($type, $message,
Scode, Serror) {
Sdata = array(
"type" => S$type,
"message" => Smessage,
"code" => Scode,
"aerror" => Serror
);
return $data;

<?php
namespace App\Http\Controllers;
use Illuminate\Http\Request;

use App\History;
use Illuminate\Support\Facades\DB;

MANUAL USER | 33
Dives Digital Identification Vehicle Sistern |



class HistoryController extends
Controller {

public function index () {
Sdata =
DB::table('histories')
->join('kendaraans',
'kendaraans.id', '=!',
'histories.id kendaraan')
->jecin('penggunas’',
'penggunas.id', '=',
'kendaraans.id_pengguna')
->select ('histories.*"',
'kendaraans.id pengguna',
'kendaraans.merk kendaraan’,
'penggunas.nama')
>orderBy('histories.tgl update’,
'desc') -
=Zgati()F

$status = $this-
>retrovitResponse ("success",
"success", 200, false);
return response()-
>json(array("status"™ => $status,
"data" => $data), 200);
}

public function lastUpdate() {
$data =

DB::table('histories')
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->7jo0in('kendaraans',
'kendaraans.id', '=',
'histories.id kendaraan')

->join('penggunas',
'penggunas.id', '=',
'kendaraans.id _pengguna')

->select('histories.*',
'kendaraans.id pengguna',
'penggunas.nama’)
>orderBy('histories.tgl update’',
'desc')

“=EIrEt ()

Sstatus = $this-
>retrovitResponse ("success",
"success", 200, false);

return response()-
>jsen (array("status" => S$status,
"data" => S$data), 200);

}

public function show (History
Shistory) {

Sstatus = Sthis-
>retrovitResponse ("success",
"success", 200, false);

return response()-
>json(array("status" => $status,
"data" =>
History: :where("id kendaraan",
Shistory->id kendaraan)->get()));

}
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public function store (Request
$request) {

Shistory =
History::create ($request->all());
$status = Sthis-

>retrovitResponse ("success",
"success", 201, false);

return response () -
>json(array("status" => S$status,
"data" => Shistory), 201);
}

public function update (Request
$request, History $history) {
$history->update ($request-
>all()):
$status = S$this-
>retrovitResponse ("success",
"success", 200, false);

return response()-
>json(array("status" => S$status,
"data" => Shistory), 200);

1

!

public function delete(History
Shistory) {
Shistory->delete();
Sstatus = $this-
>retrovitResponse ("success",
"success", 200, false);
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return response()-
>json(array("status" => S$status),
204) ;
}

public function
retrovitResponse (Stype, $message,
$code, Serror) |
Sdata = array(
"type" => $type,
"message”" => Smessage,
"code" => Scode,
"error" => Serror
i
return $data;
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